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Who do you TRUST most?

Ziel: Entwurf einer eigenen Root-CA mit vertrauenswurdigen SSL-Zertifikaten

Should you consider using self-signed certificate chains when free and widely recognized
certificates are readily available?

o Self-signed certificates can be just as secure as publicly trusted certificates.

e They establish a chain of trust, where each party is well-known and directly
controlled.

¢ You have full control of the PKI and the validity of each certificate. No external party
can invalidate the certificates.

The whole foundation of Web Public Key Infrastructure (PKI) is built upon chains of trust:
“Il trust this certificate as it has been issued by a reputable authority that | know | can
trust.”

But for internal domains there is really no need to use a public issuer as the domains are
accessed in a controlled environment. A good alternative is to roll your own PKI with a
private Root Certificate Authority.

Also keep in mind that using a public CA for internal certificates will reveal more of your
internal infrastructure, as details will be readily available on sites such as crt.sh .

Motivation

Seit den “Snowden”-Enthullungen im Jahr 2013 (2 ist klar, dass nur mit einer echten Ende-zu-
Ende-Verschllsselung eine wirklich vertrauliche Datenubertragung in jedem Netzwerk
gewabhrleistet werden kann.

Dazu braucht man diverse Zutaten, wie eine PKI, eine Hierachie von CAs und X.509-
Zertifikate die Chains-of-Trust bilden. Dieser Vortrag soll diese Themen naher beleuchten
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und die praktische Machbarkeit mit bekannten und neuen Open-Source-Tools (z.B. cfssl
oder smallstep ) zeigen.

TOP SECRET//SI//NOFORN

Current Efforts - Google

(Goode CrLoud

.

A
oy
* 5
B
w i * * @
o
»*
P
27 o

I

GFE = (oea\e $sL pdded Trqif\'g "
Front . “Z“\‘MA cloo de
Serves hewe.

TOP SECRET//SI//INOFORN

This 2013 National Security Agency (NSA) slide describing how data from Google's
internal network was collected by intelligence agencies was eye-opening—and
shocking—to many technology companies. The idea that an attacker could read
messages passed between services wasn't technically groundbreaking, but it did
reveal a security flaw in the way many distributed systems were designed. Many
companies only encrypted the data to the border of their datacenter, not inside. The
slide showed that private physical networks are being subverted to extract data
passing through them. And just because a network has a security perimeter, it
doesn’t mean that data can be safely sent between applications unencrypted inside
that perimeter. In short: treat your own network as hostile.

3. Definitionen

Eine “Public Key Infrastructure” (PKI) ist ein System aus vertrauenswirdigen
Zertifizierungsstellen (CAs), die eine hierarchische Vertrauenskette (Chain-of-Trust) bilden, um
einem Endgerat und einem Netzwerkserver eine abgesicherte Kommunikation via “Transport
Layer Security” (TLS) zu ermdglichen.

TLS (friher SSL) ist die Basis fur das HTTPS-Protokoll. Es werden X.509 Zertifikate benutzt, um
das Vertrauen zwischen den Kommunikationspartnern herzustellen und danach einen Session-
Schlissel auszutauschen und zu benutzen.



X.509-v3 ist ein ITU-Standard, der das Format von “Public Key Certificates” definiert.
Ein X.509 Zertifikat verknlpft eine /dentitdt mit einem Public Key mittels einer Digital Signature.

X.509 Zertifikate existieren in Base64 Formaten PEM (.pem, .crt, .ca-bundle), PKCS-7 (.p7b,
.p7s) und bindren Formaten DER (.der, .cer), PKCS-12 (.pfx, .p12).

Die technische Basis fur die Erstellung der Public Keys, Private Keys und Digital Signatures ist die
asymmetrische Verschllsselungstechnik. Entweder unter Nutzung des RSA-Algorithmus oder auf
Basis von ECC (Elliptic Curve Cryptography). Ubersichten iiber beide Verfahren kénnen hier (2
oder hier (2 eingesehen werden.

The anatomy of a certificate

Common Name . . Public Key
and Organziation . .
DNS name *  SSL Certificate Issuer Signature
[ :
Dates valid Issuer Name

and Organziation

& CLOUDFLARE

Im Blog von Bityard (2 gibt’s eine gute Zusammenfassung und Ubersicht zum Thema.

4. Anleitung von SUSE

¢ Internet-Ressourcen: Link @ zum Artikel und Glossar (4 der Fachbegriffe.
o PDF-Datei zum Herunterladen.
o Als Tool wird openssl benutzt.
¢ Erzeugen von Client Keys, Certificate Signing Requests (CSR) und einer privaten CA.
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e Erzeugen von Zertifikaten und Installation von “Certificate Chains” im Linux Trust Store.

5. Methoden zum Aufbau einer eigenen Certificate Authority und Self-Signed Certificates

A certificate contains an identity (hostname, organization, etc.) and a public key (RSA, DSA,
ECDSA, ed25519, etc.), and is either signed by a Certificate Authority or is Self-Signed.
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5.1. Werkzeuge fiir die Kommandozeile

5.1.1. DER Klassiker: openssl

Oft benutzt. Hat 'tausende’ Optionen. — Kompliziert und untbersichtlich!



Generate CA

1. Generate RSA key

openssl genrsa -aes256 -out ca-key.pem 4096

2. Generate a public CA Cert

openssl req -new -x509 -sha256 -days 365 -key ca-key.pem -out ca.pem

View Certificate’s content

openssl x509 -in ca.pem -text

openssl x509 -in ca.pem -purpose -noout -text

Generate Certificate

1. Create an RSA key

openssl genrsa -out cert-key.pem 4096

2. Create a Certificate Signing Request (CSR): specify the identity as subject or common
name.

openssl req -new -sha256 -subj "/CN=yourcn" -key cert-key.pem -out cert.csr

3. Create an extfile with all the SANs (subject alternative names)

echo "subjectAltName=DNS:your-dns.record,IP:257.10.10.1" >> extfile.cnf

echo "extendedKeyUsage = serverAuth" >> extfile.cnf

4. Let the CA create the signed certificate

openssl x509 -req -sha256 -days 365 -in cert.csr -CA ca.pem -CAkey ca-key.pem \

-out cert.pem -extfile extfile.cnf -CAcreateserial




Convert Certificates

COMMAND CONVERSION

openssl x509 -outform der -in cert.pem -out cert.der PEM to DER

openssl x509 -inform der -in cert.der -out cert.pem DER to PEM
openssl pkcs12 -in cert.pfx -out cert.pem -nodes PFX to PEM
Verify Certificates

openssl verify -CAfile ca.pem -verbose cert.pem

Alternatives PKI-Tool von OpenVPN: easy-rsa

Easy-rsa ist ein Shell-Skript 2 und Frontend flr openssl .

e Tool und Quellcode kdnnen von Github (2 heruntergeladen werden.

e Daich keine Erfahrung damit habe, wird deshalb hier nur die Existenz erwahnt.

cfssl von Cloudflare macht’s einfacher

Cfssl ist ein Tool von Cloudflare aus dem Jahr 2014 (4 , welches ohne die Verwendung von
openssl auskommt.

e Syntax und Kommando-Optionen sind einfacher zu verstehen.
e Tool und Quellcode kdnnen von Github (2 heruntergeladen werden.

e Erganzende Blog-Artikel aus 2015 (2 und 2016 (4 erlautern weitere Details des Toolsets.

Da die offizielle Dokumentation von cfssl etwas durftig ist, sind diese privaten Blog-
Artikel sehr hilfreich!

e Rob Blackbourn (2
e Christofer J. Ekervhen (4

e Vianney Bouchaud (2
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e Yamli (4
e Kal Feher (4
e Srdan Dukic (4

Aus diesen Griinden ist gai338 das (bis jetzt) von mir bevorzugte Tool zum Arbeiten mit
X.509-Zertifikaten. Diese Position kdnnte ihm aber von der Neuentdeckung Smallstep
streitig gemacht werden.

Private-Key und CSR Dateien fiir einen Webservice erstellen

1. Spezifikation fur den CSR als JSON-Datei erstellen. Dabei gleich alle SANs (“Subject
Alternate Names”) in den Abschnitt “hosts” einfugen. Das kdnnen sowohl DNS-Namen
(FQDN) als auch IP-Adressen sein.

"CN": "my-service.fqdn.tld",
: {
"algo": "ecdsa",
"size": 256

3,

"names":
{
IICII: ||DEII’
IISTH: ”RLP”’

"L": "Ludwigshafen",
"0": "AG MicroComputer",
”OU”: ”Pagongll

}

1.
"hosts": [

"my-service.fqdn.tld",
"10.12.13.14"

2. Public und Private KEY fiir den CSR erstellen und von JSON- in's PEM-Format wandeln.

$ cfssl genkey my-service-csr.json | cfssljson -bare my-service
2025/03/21 15:14:28 [INFO] generate received request
2025/03/21 15:14:28 [INFO] received CSR
2025/03/21 15:14:28 [INFO] generating key: rsa-2048
[INFO] encoded CSR

2025/03/21 15:14:28

$1ls -1
-rw-r--r-- 1 pagong users 1155 Mar 21 15:14 my-service.csr
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-rw-r--r-- 1 pagong users 322 Mar 21 15:08 my-service-csr.json
1 pagong users 1679 Mar 21 15:14 my-service-key.pem

$ cfssl certinfo -csr my-service.csr

3. CSR Datei von (irgend)einer CA unterschreiben lassen. Damit erhalt man die signierte CRT
Datei.

e 7.B.von openssl oder step-ca oder OPNsense

e oder auch von cfssl : siehe nachster Abschnitt

4. Fertiges Zertifikat (CRT-Datei) anzeigen.

$ cp my-service.pem my-service.crt

$ cfssl certinfo -cert my-service.crt

Signieren eines CSR von einer CA = Ausstellen eines Zertifikats (CRT) fiir einen
Webservice

1. Lokales Signieren

$ cfssl gencert -ca my-ca.pem -ca-key my-ca-key.pem my-service-csr.json |

cfssljson -bare my-service

2. Remote Signieren

$ cfssl gencert -remote=remote_server my-service.csr.json |
cfssljson -bare my-service

3. Fertiges Zertifikat (CRT-Datei) anzeigen.

$ ls my-service*
my-service.csr
my-service-csr.json
my-service-key.pem
my-service.pem

$ cp my-service.pem my-service.crt
S cfssl certinfo -cert my-service.crt

4.Beim cfssl sign Vorgang kann auch noch eine JSON-Konfigurationsdatei cfssl-cfg.json
mit Profile-Definitionen genutzt werden, um das “Finetuning” des Verwendungszwecks (oder
anderer Parameter) des Zertifkats anzupassen.
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$ cfssl sign -config cfssl-cfg.json -profile profile name \
-ca ca.pem -ca-key ca-key.pem my-service.csr |
cfssljson -bare my-service

Eigene Root-CA erstellen

Dieses Beispiel (2 wurde von Rob Blackbourn ubernommen.

1. Spezifikation flir die CA als JSON-Datei erstellen.

"CN": "Custom Widgets Root CA",
"key": {
"algo": "rsa",
"size": 4096
I
"names": [
{
"GB",
"London",
"0": "Custom Widgets",
"OU": "Custom Widgets Root CA",
"ST": "England"

2. Public und Private KEY flr die CA erstellen. Die Root-CA ist daran erkennbar, dass sie selbst
signiert ist.
(Also Issuer = Owner bzw. Subject).

$ cfssl genkey -initca root-ca-csr.json |
cfssljson -bare root-ca

$ ls root-ca*
root-ca.csr
root-ca-csr.json
root-ca-key.pem
root-ca.pem

3. PEM- in CRT-Datei kopieren und Zertifikat anzeigen.

$ cp root-ca.pem root-ca.crt
S cfssl certinfo -cert root-ca.crt
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Eigene (intermediate) Branch-CA erstellen

Dieses Beispiel (2 wurde ebenfalls von Rob Blackbourn ibernommen.

1. Spezifikation fur den CSR der Branch-CA als JSON-Datei erstellen.

"CN": "Custom Widgets Branch CA",
"key": {

"algo":

"size":

"GB",
"London",
: "Custom Widgets",
: "Custom Widgets Branch CA",
: "England"

2. Public und Private KEY fiir den CSR der Branch-CA erstellen. Dabei entsteht auch eine nicht
bendtigte PEM-Datei.

$ cfssl gencert -initca branch-ca-csr.json |
cfssljson -bare branch-ca

3. Und den CSR gleich von der Root-CA signieren lassen. Dabei wird die ‘unndtige’ durch die
‘richtige’ PEM-Datei ersetzt.

$ cfssl sign -config cfssl-cfg.json -profile branch_ca \
-ca root-ca.pem -ca-key root-ca-key.pem branch-ca.csr |
cfssljson -bare branch-ca

$ 1ls branch-ca*
branch-ca.csr
branch-ca-csr.json
branch-ca-key.pem
branch-ca.pem

4. PEM- in CRT-Datei kopieren und Zertifikat anzeigen.
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$ cp branch-ca.pem branch-ca.crt
$ cfssl certinfo -cert branch-ca.crt

Eigene Leaf-CA erstellen

Dies erfolgt ahnlich zum Vorgang der Signierung der Branch-CA durch die Root-CA. Nur wird in
diesem Fall die Leaf-CA durch die Branch-CA signiert.

1. Spezifikation flr den CSR der Leaf-CA als JSON-Datei erstellen.

"CN": "Custom Widgets Leaf CA",
"key": {

"algo": "ecdsa",

"size": 384

"GB",
"London",
"Custom Widgets",
: "Custom Widgets Leaf CA",
: "England"”
}
1:
"ca": {
"expiry": "8760h"
}
}

2. Public und Private KEY flir den CSR der Leaf-CA erstellen. Dabei entsteht auch eine nicht
bendtigte PEM-Datei.

$ cfssl gencert -initca leaf-ca-csr.json |
cfssljson -bare leaf-ca

3. Und den CSR gleich von der Branch-CA signieren lassen. Dabei wird die ‘'unndtige’ durch die
‘richtige’ PEM-Datei ersetzt.

$ cfssl sign -config cfssl-cfg.json -profile leaf ca \
-ca branch-ca.pem -ca-key branch-ca-key.pem leaf-ca.csr |
cfssljson -bare leaf-ca

$ 1s leaf-ca*
leaf-ca.csr
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leaf-ca-csr.json

leaf-ca-key.pem

leaf-ca.pem

4. PEM- in CRT-Datei kopieren und Zertifikat anzeigen.

$ cp leaf-ca.pem leaf-ca.crt
S cfssl certinfo -cert leaf-ca.crt

Verwendung von KEY und CRT Dateien

Umwandeln von KEY- und CRT-Dateien zu Kubernetes secrets zur Verwendung in einem mit
TLS abgesicherten Web-Service.

$ CRT="SSRCDIR/my-service.crt"
$ KEY="SSRCDIR/my-service.

$ kubectl -n my-namespace create secret tls my-service-tls --cert="SCRT" --key="SKEY"
$ kubectl -n my-namespace describe secret my-service-tls

Grafische Werkzeuge

Firewall OPNsense (GUI im Web-Browser)

OPNsense ist eine Firewall (7 -Software, die auf FreeBSD basiert. Neben der Aufgabe als Firewall
konnen damit Uber Plugins auch viele andere Netzwerk-Dienste (u.A. DNS, DHCP, NTP, VPN,
etc.) eingerichtet und verwaltet werden.

e Download von OPNsense als ISO-Datei (2

e Link zur Online-Dokumentation (2
OPNsense enthalt Plugins, die ein grafisches Frontend zu openssl und ACME bieten:
e HowTo “Setup Self-Signed Certificate Chains” (2

o etwas einfacher zu Bedienen als die Kommandozeile
o aber ohne Hintergrundwissen zu X.509 bleibt’s schwierig
e Online-Artikel zur Nutzung von OPNsense als CA:

o SSLTrust 3

o Zenarmor (4
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e Online-Blog-Artikel zum Plugin acme-client :

o Dennis Schroder 4
o ClouDNS ©
o HomeNetworkGuy (4

e Links zur Online-Dokumentation von OPNsense:

o Kapitel “Trust” 2
o Details zum Plugin-API (2 acmeclient

o Details zum Core-API [F trust

Windows

Im MatrixPost-Blog wird die Nutzung der PKI Mdglichkeiten in Windows Server gezeigt.

THEMA LINK

PKI Design Part12
Offline Root CA Part2 (4
Intermediate CA Part3 (4
Client Certificates Part4 (3

Auto Enrollment Part5

Automationswerkzeuge

Zertifikate fiir Kubernetes: cert-manager

Der cert-manager (4 wird flr das automatisierte Anfordern und Erneuern von Zertifikaten in
Kubernetes-Clustern benutzt.

o Umfangreiche Dokumentation (2 und Source-Code bei Github (7 .
e Installation erfolgt Uber ein Helm-Chart (7 .

Neuentdeckung: Open Source PKI Smallstep
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Wahrend der Vorbereitung dieses Vortrags bin ich auf ein “YouTube”-Video und Blog gestossen,

in welchem Open-Source-Tools der Firma Smallstep zum Aufbau einer privaten CA benutzt
wurden:

o “Self-Hosted TRUST with your own Certificate Authority” (2

Bei der weiteren Recherche habe ich dieses Dokument des Firmengrinders Mike Malone

gefunden. Dort werden alle Eigenschaften von X.509v3-Zertifikaten und deren Life-Cycle klar
und prézise erlautert:

e “Everything you should know about certificates and PKI but are too afraid to ask” (4
Ich bin von Smallstep begeistert und werde mich verstarkt darum kimmern. Leider war

die Zeit bis zum LinuxTag zu kurz, um tiefer einsteigen zu kénnen. Die beiden u.g. Tools
konnten - erganzen (oder sogar ersetzen).

Step-CA

Server-Tool:

e Dokumentation (2 ] zum Tool step-ca zum Betreiben einer Certificate Authority CA.
e Download des Source-Codes und der Software-Pakete von Github (4

¢ Betrieb als Linux-Daemon oder im Docker-Container moglich

Step CLI

Client-Tool:

e Dokumentation (2 zum CLI-Tool step zum Anfordern und Verwalten von Zertifikaten aller
Art.

e Download des Source-Codes und der Software-Pakete von Github (4

Beispiele

Diese Artikel im Smallstep-Blog werden als Basis und Inspiration flir meine Experimente dienen.

e “Run your own private CA & ACME server using step-ca” (2 (als PDF)
e “Build a Tiny Certificate Authority For Your Homelab” (2 (als PDF)
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ACME: Automated Certificate Management Environment

Let's Encrypt

Das Projekt “Let’'s Encrypt” (2 hat zum Ziel, dass alle Web-Seiten und samtlicher Internet-Traffic
nur noch in verschlisselter Form (per TLS-Protokoll) Gbertragen werden.

e Friher waren die dafur bendtigten Zertifikate recht teuer und konnten zusammen mit einer
DNS-Domane gekauft werden. (Achtung: ABO-Modell!)

e Es gibt aber DynDNS-Provider, die einer Hobby-Seite Zugang zu einer kostenlosen DNS-
Domaéane ermdoglichen. Und seit es “Let’s Encrypt” gibt (also seit 2015 (2 ), werden auch die
dazu passenden X.509-Zertifikate kostenlos ausgestellt.

Zur Uberpriifung, dass ein Webseiten-Betreiber tatséchlich die Kontrolle {iber den FQDN der
Webseite hat, wurde das ACME (4 -Protokoll eingefiihrt, welches “Domain-Validation” DV (4
benutzt:

1. Auf Anfrage durch den ACME-Client erzeugt der ACME-Server eine zufallige Information, die
der Client auf einer speziellen HTTP-Unterseite der Webseite (oder als TXT-Record im DNS-
System) verdffentlicht.

2. Im nachsten Schritt Uberprift der ACME-Server die HTTP-Unterseite (oder den TXT-
Record). Falls dort die gleiche Zufallsinformation gefunden wird, die er vorher dem ACME-
Client gesendet hat, kann er davon ausgehen, daB der Client echt ist. Mit anderen Worten:
die Domane ist validiert.

3. Zum Schluss stellt der ACME-Server ein zeitlich befristetes Zertifikat (meist 90 Tage) fur die
DNS-Domane des ACME-Clients aus, welches fiir die Ubertragung der per TLS
verschlisselten HTTPS-Seiten des Web-Servers genutzt wird.

4. Vor Ablauf der Frist muss sich der ACME-Client wieder an den ACME-Server wenden und
um die Zertifikats-Verlangerung (d.h. Austellung eines ‘frischen’ Zertifikats) bitten.

Neben “Let’s Encrypt” gibt es auch noch andere Provider, die die ACME-Protokolle
implementiert haben und oft auch kostenlose X.509-Zertifikate ausstellen.

Neueste Nachrichten!

¢ Laut “Heise”-Newsticker (4 arbeitet “Let’s Encrypt” an der Verklrzung (2 der Zertifkats-
Gultigkeit von 90 auf 6 Tage.

¢ Die Trump-Regierung stoppt (2 die Forderung von Open-Source-Projekten, wie “Let’s
Encrypt”, “TOR” und “F-Droid".


https://de.wikipedia.org/wiki/Let%E2%80%99s_Encrypt
https://de.wikipedia.org/wiki/Let%E2%80%99s_Encrypt
https://de.wikipedia.org/wiki/Let%E2%80%99s_Encrypt
https://de.wikipedia.org/wiki/Let%E2%80%99s_Encrypt
https://letsencrypt.org/
https://letsencrypt.org/
https://letsencrypt.org/
https://letsencrypt.org/
https://de.wikipedia.org/wiki/Automatic_Certificate_Management_Environment
https://de.wikipedia.org/wiki/Automatic_Certificate_Management_Environment
https://de.wikipedia.org/wiki/Automatic_Certificate_Management_Environment
https://de.wikipedia.org/wiki/Automatic_Certificate_Management_Environment
https://de.wikipedia.org/wiki/Automatic_Certificate_Management_Environment
https://letsencrypt.org/de/how-it-works/
https://letsencrypt.org/de/how-it-works/
https://letsencrypt.org/de/how-it-works/
https://letsencrypt.org/de/how-it-works/
https://letsencrypt.org/de/how-it-works/
https://www.heise.de/news/Let-s-Encrypt-Ende-von-Zertifikat-Ablauf-Nachrichten-und-6-Tage-Zertifikate-10269311.html?view=print
https://www.heise.de/news/Let-s-Encrypt-Ende-von-Zertifikat-Ablauf-Nachrichten-und-6-Tage-Zertifikate-10269311.html?view=print
https://www.heise.de/news/Let-s-Encrypt-Ende-von-Zertifikat-Ablauf-Nachrichten-und-6-Tage-Zertifikate-10269311.html?view=print
https://www.heise.de/news/Let-s-Encrypt-Ende-von-Zertifikat-Ablauf-Nachrichten-und-6-Tage-Zertifikate-10269311.html?view=print
https://letsencrypt.org/2025/01/16/6-day-and-ip-certs/
https://letsencrypt.org/2025/01/16/6-day-and-ip-certs/
https://letsencrypt.org/2025/01/16/6-day-and-ip-certs/
https://letsencrypt.org/2025/01/16/6-day-and-ip-certs/
https://www.heise.de/news/Nach-Trump-Dekret-Kampf-um-US-Foerdermittel-fuer-Tor-F-Droid-und-Let-s-Encrypt-10328226.html?view=print
https://www.heise.de/news/Nach-Trump-Dekret-Kampf-um-US-Foerdermittel-fuer-Tor-F-Droid-und-Let-s-Encrypt-10328226.html?view=print
https://www.heise.de/news/Nach-Trump-Dekret-Kampf-um-US-Foerdermittel-fuer-Tor-F-Droid-und-Let-s-Encrypt-10328226.html?view=print
https://www.heise.de/news/Nach-Trump-Dekret-Kampf-um-US-Foerdermittel-fuer-Tor-F-Droid-und-Let-s-Encrypt-10328226.html?view=print

SmallStep ACME

Both step and step-ca are natively integrated with the ACME protocol. step can be used to
request ACME certificates from any ACME server, while step-ca is a fully functional private
ACME server that works with all popular ACME clients.

Zero-SSL

Im “Caddy” Webserver ist, anstelle von “Let’s Encrypt”, der Zertifikatsprovider “Zero-SSL”
automatisch aktiviert.

Andere ACME-Clients

Certbot

Certbot is EFF’s tool to obtain certs from “Let’s Encrypt”. It's written in Python.
It can also act as a client for any other CA that uses the ACME protocol.

e Website (4
e Github (2

LEGO

Let's Encrypt/ACME client and library written in Go.

e Website (4
e Github (3

acme.sh

A pure Unix shell script implementing ACME client protocol.

o Wiki (2
e Github (¥
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Eigene Root-CA in Betriebssystemen verankern

On SUSE

e Copy the CA certificate ( My-CA.pem ) or ( My-CA.crt ) to /etc/pki/trust/anchors/
e Now run:

sudo update-ca-certificates

Refer to documentation here (2 and here. (2 See also Blog post. (4

On Fedora

e Copy the CA certificate ( My-CA.pem ) to /etc/pki/ca-trust/source/anchors/ or /usr/share/
pki/ca-trust-source/anchors/

e Now run:

sudo update-ca-trust

Refer to documentation here. (2 See also Blog post. (2
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On Debian & Derivatives

e Copy the CA certificate ( My-CA.pem ) or ( My-CA.pem ) into /usr/local/share/ca-
certificates/ .

e Update the Cert Store with:

sudo update-ca-certificates

Refer to documentation here (4 and here. (2

On Arch

System-wide — Arch(p11-kit)
(From arch wiki)

Run (as root)

trust anchor --store My-CA.crt

The certificate will be written to /etc/ca-certificates/trust-source/My-CA.p11-kit and the
“legacy” directories automatically updated.

If you get “no configured writable location” or a similar error, import the CA manually:

Copy the certificate to the /etc/ca-certificates/trust-source/anchors/ directory.

and then

sudo update-ca-trust

wiki page here (4

See also:

e Hochschule Schmalkalden (4
e MatrixPost ¥

On Windows

Assuming the path to your generated CA certificate as C:\My-CA.pem , run:
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Import-Certificate -FilePath "C:\My-CA.pem" -CertStoreLocation Cert:\LocalMachine\Root

e Set -CertStorelLocation to Cert:\CurrentUser\Root in case you want to trust certificates
only for the logged in user.

OR

In Command Prompt, run:

certutil.exe -addstore root C:\My-CA.pem

e certutil.exe is a built-in tool (classic System32 one) and adds a system-wide trust anchor.

Siehe auch “Step 4 — Import root certificate to users devices” im Kapitel “openssl” bzw. den “Step
5” im Kapitel “cfssl” in einer anderen Fundstelle (7 .

For Windows:

e Click Open
e Go to File > Add/Remove Snap-in
e Click Certificates and Add

e Select Computer Account and click Next

e Select Local Computer then click Finish

e Click OK to go back to the MMC window

e Double-click Certificates (local computer) to expand the view

o Select Trusted Root Certification Authorities, right-click on Certificates, and select “All
Tasks” then “Import”

e Click Next then Browse. Change the certificate extension dropdown next to the filename
field to “All Files (.)” and locate the “your-root-cert-name.pem” file, click “Open”, then “Next”

nou

» Select “Place all certificates in the following store”. “Trusted Root Certification Authorities
store” is the default. Click “Next” then click “Finish” to complete the wizard

» To verify, see your imported root certificate if it's listed in the list of root certificates

Auch im “Proxmox”-Wiki gibt es einen Artikel zum Hinzufligen (2 von Zertifikaten zum Windows
Trust-Store.
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On macOS

Assuming the path to your generated CA certificate is ~/My-CA.pem , run (as root):

security add-trusted-cert -d -r trustRoot -k /Library/Keychains/System.keychain ~/My-CA.

A dialog box will appear asking for an administrator’s username and password. Enter it, and it will
be stored in the system keychain. This can be verified by opening the Keychain Access
application ( /Applications/Utilities/Keychain Access.app ). On the sidebar under System
Keychains select System , and the new certificate should be listed.

Siehe auch “Step 4 - Import root certificate to users devices” im Kapitel “openss|” bzw. den “Step
5” im Kapitel “cfssl” in einer anderen Fundstelle (7 .

For MAC OS:

e Open up Keychain Access by searching it on Spotlight (clicking the Magnifying glass located
on the upper right corner)

e Select File > Import Items. Find the generated root certificate. Select System as “Destination
Keychain”

e Enter password when prompted

e Logoff to take effect

Auch im “Proxmox”-Wiki gibt es einen Artikel zum Hinzufligen (2 von Zertifikaten zum Trust-
Store von macOS.

Eigene Root-CA in mobilen Geraten verankern

On Android

The exact steps vary device-to-device, but here is a generalised guide:

1. Open Phone Settings

2. Locate Encryption and Credentials section. It is generally found under Settings >

Security > Encryption and Credentials
3. Choose 1Install a certificate
4. Choose CA Certificate

5. Locate the certificate file My-CA.pem on your SD Card/Internal Storage using the file
manager.
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6. Select to load it.

7. Done!

¢ “Importing SSL Certificate on Android or iPhone” TitanHq (3

OnioOSs

Apple makes this far more difficult than it should be:

1.Send My-CA.pem to the iOS device through iCloud, AirDrop, or a direct download from your
server.

2. After downloading a dialog will appear on screen telling you that the profile has been
downloaded.

3. Open the Settings app, and a Profile Downloaded item will be at the top. If it is not there,
you may find it in General - VPN & Device Management .

. Click 1Install .
. The device will ask for your passcode. Enter it.

. The device will then warn you about the certificate. Click Install again.

N OO o b~

. And, as if clicking Install twice wasn’t enough, a confirmation button will appear at the
bottom of the screen. Click Install one last time.

8. Done!

¢ “Importing SSL Certificate on Android or iPhone” TitanHq (3

Eigene Root-CA in Web-Browser integrieren

Browser: Firefox

Tipps von Mozilla:

1. “Set up Certificate Authorities (CAs) in Firefox” im Mozilla Support (4
(enthalt Tipps fur Windows und macOS und Android und Linux)

2. You can do that in the Certificate Manager:
“Tools > Options > Advanced > Certificates: View Certificates”

To import a client certificate to Firefox, open the menu and select Preferences.
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Navigate to the Certificates tab and click View Certificates, then Your Certificates, and finally,
Import.

Locate your PKCS12 file (.p12 or .pfx), enter the password, and confirm the import.
Your certificate will appear under Your Certificates in Firefox Certificate Manager.

¢ Im “Proxmox”-Wiki gibt es einen Artikel zum Hinzufligen (2 von Zertifikaten zum Trust-Store
von Firefox.

¢ “Howto import your certificate to the browser” der “World Intellectual Property Organization”
WIPO (2

¢ “Import Certificate to Mozilla Firefox” keyfactor (4

¢ “Importing SSL Certificate in Mozilla Firefox” TitanHq (4

Browser: Chrome fiir Linux

Viele Quellen sagen, dass “Chrome” (und “Edge”, etc.) den Trust-Store des Betriebssystems
nutzen!

Install Root Certificates on Chrome running on Linux

For Linux, Chrome uses its own certificate store. You can import your Root CAs in Chrome
directly.

In Chrome open Settings — Privacy and security — Security — Manage certificates —
Authorities
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Die Bilder stammen aus dieser guten Anleitung (2 von MatrixPost!

¢ Im “Proxmox”-Wiki gibt es einen Artikel zum Hinzufligen (2 von Zertifikaten zum Trust-Store
von Chrome.

¢ “Importing SSL Certificate in Internet Explorer, Google Chrome or Opera” TintanHq (4
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